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Introduction

1 Introduction

WinCan-WEB is a cloud-based service provided by the company CDLab (WinCan, Switzerland) in
collaboration with a local professional web hosting company.

This new service allows the CCTV-companies to upload their survey data to a host server, where it
can be downloaded from at any time and on any spot on the world by an end customer. So this
procedure is able to fully replace the sending of survey data as paper reports or as a batch of DVDs.

However WinCan-WEB is NOT thought to be used as a long term storage medium. Project data thus
should only be available for a limited time span.

The following documentation describes, how users can upload and download WinCanVX-projects
via WinCan-WEB and how specific project links can be sent directly to their end customers (e.g.
engineer offices).

2 Create an account

In order to be able to upload and download projects you must create your own account launching
your web browser and typing the address http://web.wincan.com. The main screen of WinCan-Web
then tells you to either sign in with an existing user account or to register as a new user:

W WinCan (CD Lab) Service & S

& Cc @ © & nhttps;//web.wincan.com/#Login oo w | | Q Suchen I 0O o =
"
WinCan B Switch backs d phots
E ro
Web ch background photo

Signin

upport@wincan.col

Remember me

Launch demo project Forgot Password LOGIN

Registration (1) as a new user requires the following information:

¢ Name of the company (case sensitive)
e Personal e-mail address (case sensitive)
e Personal password (case sensitive)

Your registration will then be confirmed automatically via e-mail. Registration will give you the right
for 45 days to use 25 GByte of server disk space for free and to create different sub-user levels.

In addition WinCan-WEB provides three user levels, which must be managed by CDLab:

1. Software company (i.e. CDLab, Switzerland)

2. CCTV-company

3. End user (civil engineers, local water authorities etc.)
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Check your profile

3 Check your profile

Once your account has been registered, you can directly type username and password and hit the
button Login to open your personal web space. Select the category Account settings and hit the tab
Profile (1) in order to check the properties of your user profile:

Projects list

System Profile Company Edit User Profile  =dit mode Settings Edit mode

Profile mode

g Management v Logo for WinCan WEB branding (Replaces Logo for user branding in additio Language:  en-US

default) Logo used in email foote company brandine Date format:  dd-MM-yyyy
124 Admin tools v /s s c Cu CHF
' | Days for default creation date of direct links:

Logo used in email heade
: Q s
4

First Name: Daniel Rss feed

e Steiner

e cdlab

Adjust observations grid to page size

e:  d.steiner@wincan.com .
e 9 Hide sections & laterals without

dsteiner@wincan.com observations for al projects

Hide nodes without observations and
~/
parts for all projects

ent Upload Exchange folder
Two factor authentication

Upload Exchange media files

all: d.steiner@wincan.com

Create project link after uploading Notify me about low space amount left

project
T canest ’

Activate the Edit mode inside the sub-category User Profile (1) in order to change the logo to be
displayed on your personal web space.

Go the sub-category Settings and activate the Edit mode (2) in order to change the language for the
texts shown on the WinCan WEB platform. In addition you may exclude some folders (3) from the
upload procedure. Finally hit the button Save (4) to confirm your changes.

4 Define and manage user groups for your company

In case several operators will be working either on different projects or together on the same
project, it may be useful to create user groups (1) and to assign the corresponding operator accounts
(2) to one specific group (3):

PBESCIS © | @ hiipsy/webmincan.com/#Mianage w @ | Q suchen noe =
Projects list PROFILE  ACCOUNT  MANAGEMENT

{é} Account settings
S ansgement ) _ .
Groups List /ADD GROUP Assign Projects Assign Users

Users
| Groups
SMTP server Project assigning: User sssigning:
Group Users  Projects Action A
IP restrictions
Managers 0 0 a |
< /s u Project name User Mail
&1 Admin tools v B 1 2 3 DECMIL GROUP, PLENTY ROAD UPGRADE - STAGE2 [ d steiner@wincan.com d.steiner@wincancom (@ a

DEMO_CH_VSA_Murten_3D
DEMO_DE_ISYBauXML

DEMO_FR_EN13508_3D

DEMO_UK_WRC3_3D [] °

Seite 4/12



Check the disk space reserved for your profile

All uploaded projects are listed then on the central part of the panel above. Highlight the user group
(3) and select those projects (4), that are meant to be updated and uploaded stepwise by different
operators over a certain period of time.

Any operator being a part of that user group will be able from now to work on a project and to upload
it, even if another user has already uploaded a part of the same project before.

5 Check the disk space reserved for your profile

Hit the tab Account right to the tab Profile and select the button Upgrade (1) in order to upgrade to a
larger storage package if ever needed:

tras  Hilfe

w Iy Account settings
1.3

Projects ist PROFILE  ACCOUNT
WinCan Option 3 (500GB) Hosting region
ﬂ Management v

s available upon request sales@wincan.com ;

| 29 Admin tools ~

| fccum

Amazon S3 Hosting region:

EU Central (Frankfurt)

Payment history Need more space?

Usage statistics
T UPGRADE

There are currently 7 different storage packages CDLab can provide for customers that want to
upload their projects to WinCan-WEB:

Hilfe

&« c @ © @ nhitpsy/webwincan.com/#UpgradeAccount w Suchen Y iNn@D e =

w i Upgrade account
M > Upgrade sccount
Projects st
25GB 100 GB
{6} Account settings CHF49.00 {+ VAT) per month  CHF 69.00 {+ VAT} per mont
Jo R
%‘n‘
?'o
‘Q Admin tools v [—\ \
[se0vi—o]
[se001=0)
Ceri=o]
Option 4 (1TB)
CHF 320.00 (+ VAT) per month
Currency Y-
Example:

If you select the cheapest storage package, 25 GByte of disk space on the HOST-server are then going
to be reserved for your account, which would be sufficient for up to 10 small projects.

Further details about prices and payment conditions can be obtained from the administrative
department of CDLab (mailto: sales@wincan.com) or from your local reseller.
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Upload and view projects with the WEB Viewer

6 Upload and view projects with the WEB Viewer

At the beginning your personal account is showing an empty listin WinCan-Web. In order to upload
a project, open it in WinCanVX and hit the command Tools > Manage Web Projects > Upload Current
project (1):

vl WinCan VX (-PROD-) v1.2020.10.0 [Admin] - [DECMIL GROUP, PLENTY ROAD UPGRADE - STAGE 2]
Projects  Printing Data Bxchange | Tools Views  WinCan Analyst Extended Modules Work Order Management Macros OEMTools  Admin
A @& %% || I = IE = Quick Filter ~| UserFilter
Az v - E’l Z st a w E-TJI Available Criteria - \(':’Q
AutoCreste  AutoCreste  Combine Abandoned  InsertNew  Calculate Move  WinCan | ManageWeb | Pro Project Show Search and
Laterals Connections * Inspections Manhole InvertLevels Inspection Validator Projects~ | Touch | Documents  Inspected Only ¥ ARPly Filter Y Apply UserFilter  Replace
Tools Manage Web Projects Quick Filter User Filter
” DECMIL GROUP, PLENTY ROAD UPGRADE - STAGE 2 Sections | Laterals Upload Current Project Q
Pipe Graph 1 x |[Sections
e Assetip v Tengt ¥ Tow ¥ [Sib v 'Address v USNode ~ DSNode + Material ¥ Profle v
J02-4 A 1 J H ZONE 7, PLENTY RD, STHMO... | :Concrete reinforced
2 JO2-3-J02-2 27.82 ZONE 7, PLENTY RD, STHMO...  J02-3 Joz2-2 Concrete reinforced 375mm
sTep 001 3 J02-2-J02-1 19.50 ZONE 7, PLENTY RD, STH MO... J02-2 J02-1 Concrete reinforced 375mm
WLC 4 J02-1-J05-4 20.35 ZONE 7, PLENTY RD, STH MO J02-1 Jos-4 Concrete reinforced 375mm
DEC 5 HOT-2A-HO1-1 1239 ZONE 6A, PLENTY RD, STH M. HO1-2A Ho1-2 Concrete reinforced 375mm
DES 6 H6-2-HO1-2 743 ZONE 6A, PLENTY RD, STH M... H6-2 HO1-2 Concrete reinforced 375mm
——DER 7 HO1-2-HO1A1 3.53 ZONE 6A, PLENTY RD, STH M... H01-2 HO1-1 Concrete reinforced 750mm
g EXG2-2-EXG2-3 4895 ZONE 5, OPP LAKE BLVD, PLE... EXG2-3 EXG2-2 Goncrete reinforced 375mm
g EXG2-2-RAIL.. 1712 ZONE 5, OPP LAKE BLVD, PLE... GREATE... EXG2-2 Concrete reinforced 375mm

The panel that follows shows the status of the process in the progress bar. Besides that it provides
you a list of all available projects on the local hard drive (1) and those which have already been
uploaded (2).

So it's possible for you to manage your personal web space directly in WinCanVX. Use the button
Log in/Log out (4) to enter the profil data of your personal web space.
| 0 WinCan Cloud | . | | _ o x |

[ e e User 1D: d.steiner@wincan.com Log out |
% |

| Local  QOnlyon'wWeb On'web and VX

|
Mame T Create Date Check project size Actions Progress statu  Progres T‘
|
Camino Ancho, 2 [Saneamiento 161062020 Check project size Upload |

|| Commune (Lot 1_Plan 52), Laus IN07I2019 Check project size Upload |

BBMET T
11.5MB

DEMO_3DGS-Map_DE 09122020 Check project size Upload

|
DEMO_3DGS-Map_EN 04/03/2020 Check project size Upload |
|| Engishofen_Flurhofstrasse_Stras 07042020 Check project size Upload I
Upload All
13.64 GB / 500 GB used 2%

Once finished you are informed via e-mail the project has been successfully uploaded to your
personal web space.
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Upload and view projects with the WEB Viewer

Please mind the following technical issues regarding the upload procedure:

When working on a large project, you may always upload the latest version of the same project:
there's a built-in intelligence in the uploader that replaces the old project database by the new
one and just adds the media files, which have not yet been uploaded.

Itis possible to continue working on a large project, while its upload is in progress.

If the Internet connection is cut for any reason, the upload won't be resumed automatically. So
you must retry to upload the same project later on.

Uploaded video clips are first converted into the format MPEG4 and then copied into the sub-
folder \Video\Sec\Web. If the conversion is not terminated, the video clip will not yet be ready
for play back. So just be patient and try again later.

As a next step you may check whether the project data are available and can be viewed from your
personal web space without any problems. After you have signed in with your account you see a list
of projects that have already been uploaded. The same project list is also shown when hitting the
Home icon (1).

Simply click on the desired project in the list (2) in order to have the section, inspection and
observation data shown directly in the Web-Viewer.

© & hitps//webwincan.com/#Home | | Q suchen n @ e =
w + Upgrade
Projects list
Projects list .
l g :|
{o} Account setting:
g Management Name Date
DEMO_CH_VSA_Murten_30 20-02-2013 1.2GB < ® O
& Admin tools

DEMO_DE_ISYBauXML

DEMO_FR_EN13508_3D

Project Links for DEMO_FR_EN13508_3D

DEMO_UK_WRC3_3D o

1 oo

28-02.2021 VAl rD

@ o

m Browse °
W Delete

Allow Download

Hit the Action button (3) to the right of the list and select the command Browse (4) to grab for specific
pictures and video clips in the corresponding project sub-folders or click on Delete (4) in order to
delete the whole project form your personal web space.

Click on the Link icon (5) and manage the links to the selected project. You can create (5a) and edit
(5b) new links to the same project, set an expiration date for each link (5b) and finally send it to the
receiver (5¢).

Make sure the option Allow Download is checked so the end customer will be able to download the
project from WinCan-Web.
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Upload and view projects with the WEB Viewer

The Web-Viewer opens the projects in a similar way as if it would be shown in WinCanVX. Simply
browse throught the list of inspected objects (i.e. sections, laterals and nodes (1)) and have a look at
the corresponding observations displayed in the table below (2).

As soon as you highlight the desired object (1a) the corresponding video clip is played back
automatically. Click on the Action button (3) and select the command Section details in order to view
the section and inspection data entered by the operator.

Datei Bearbeiten Ansicht Chronik Lesezeichen Extras Hilfe

‘W DEMO_UK_WRC3_3D

<« c © & hitpsy//webwincan.com/#Project 9| | Q suchen INn@D e =

w DEMO_UK_WRC3_3D | B prokct -

T - DEMO_UK_WRC3_3D

Projects st

SECTIONS ‘I

Total Length [m]  Upstream Node Downstream Node

60.00
20.00

4 WCIX 2650 wci @ Section details

% i i e 4 Show pipe preview

11-11-2010 17:01

1 0.00 4500 ST Start of survey e ™ (S

2 0.00 4500 MH Manhole 4
= s
§ oN 3 0.00 4500 WL Water level, 5% of sewer height
{ TN
( _’ ';;j 4 5.80 39.20 EM) Encrustation, medium at joint from 7 o'... 3 o] 0] 00:03:29 [
VL

5 17.80 27.20 CN Connection, at 3 o'clock, 100mm diame...

Hovering with the mous pointer over a specific photo icon directly shows the picture preview (4);
clicking on the photo icon on the other hand opens the original picture size in a separate panel.

‘W DEMO_UK_WRC3_3D

< c @ O & ntt

ps://web.wincan.com/#Project

n@oe =

w DEMO_UK_WRC3_3D | B prokct -

ft DEMO_UK_WRC3_3D

Projects list

SECTIONS

Total Length [m] ~ Upstream Node Downstream Node

a'e

MH

8
i
WL

WC1X

WCex 42.00 WCé 4

11-11-2010 17:01

No. m+ m- Code Observation Remark Continu... Structu... Service Pl

1 0.00 45.00 ST Start of survey

W N 2 0.00 4500 MH Manhole 4

Water level, 5% of sewer height

Encrustation, medium at joint from 7 0.

To quit the Web-Viewer and to get back to the list of the uploaded projects click on the Home icon

(5).
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Download and view projects with the LightViewer

The button Project located at the top of the Web-Viewer interface opens a panel that provides
general information about the project (1), a direct access to specific project documents (PDF reports,
pictures (2)) as well three download possibilities (3):

(d C @ 08 == wincan.com/ 167 6912-4 4 & 9 ® 8 =

v' i DEMO_UK_WRC4_3D B PROJECT -+ & DOWNLOAD PROJECT

DEMO_UK_WRC4_3D

0 Project Documents a

| Tools Download
1B Media bucket % Download as ZIP
DEEJ 10
4 @ Drawing £ Download by Too
‘ CN
{ 4 28 participants % Download LightViewer
CN n
D cN ik scoring
MHF

Mind that the Web-Viewer is unable to show inclination curves, Map data or pipe and manhole scans.

In order you can view these kind of data you will have to download the project as a ZIP file and open
itin WinCanVX.

A short description for each download possibility (3) is shown in a direct help box as soon as you
hover with the mouse pointer over the corresponding command button.

7 Download and view projects with the LightViewer

Hitting the command Download by LightViewer creates a package providing the project together
with the LightViewer application. After the download you simply have to unzip the file and double-
click on the LightViewer icon (4). The data finally are shown as illustrated below:

‘W VXLightViewer - DEMO_UK_WRC3_3D

2.

- [m] X

WinCan

w |

Section Inspection

Code  Observation

00:06:44/00:17:58
v I
b App_Data
# PR [Total LenTown or fRoad Upstre{DownsMaterizDia/He| :
10X 2000 London Piccadilly Street |2 3 O 350000 i Prcuects
5w (T ——— .
2 WCIX 2650 London PiccadilyStret8 WCT 2 PVC 250000 5
3 X 6000 london PiccadiyStrest 1 2 CO 450000 ystem
44X 4500 london PiccadillyStrest 4 |5 CO 350000 D 20171205.2.Index.bet
O N e G t - .
B ey ; 2] AUTORUM.INF
[ Disk

Favicon.ico
LightViewer.exe
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Download and view projects with WinCanVX

8 Download and view projects with WinCanVX

You may also download the project directly to your local hard drive as a ZIP file or use a specific
application that controls the download procedure. Next proceed as follows in order to view the
project data:

Go to www.wincan.com > Downloads

Download the latest productive version of WinCanVX
Double-click on the file WinCanVX_SETUP and confirm all the installation steps.
Unzip the project.

Double-click on the WinCanVX desktop icon to launch the software in the Viewer mode

Hit the command Project > Open Project (1).

Browse for the sub-folder DB, select the project database (2) and click on the button Open (3) to
show the data in WinCanVX:

Projects Printing Tools Views
QOO SO

d
=t
New

Project

=
Open | Close Refresh Manage Refresh | A
Prgject | Project Project Projects  List

Manage

WinCan VX (-PROD-) ¥1.1.2017.10 [Operator] - [DEMO_US_PACP]

Extended Modules Macros @

©

ssign Project

Participants

Meta Data

) US PACP | Sections | Laterals Nodes

& x [[Sections 2 x [[Photo/Video 3
Pipe SegmentRe 7 TotalLe W/ City V| Street w| Upstream v | ~~ v Downstr ¥ Material | Shap ¥ 47
1 NY7_PA3 51.60 NewYork  ParkAvenue 3 S 4 concrete
2 NYs_PA4 6310 NewYork  ParkAvenue 4 S 5 concrete
- 3 NYSPAS 40.00 NewYok  ParkAvenue 5 EL concrete
4 NY1BWI 12000 NewYork  Broadway 10 2 N concrete
5 NY2BW2 13022 NewYork  Broadway 11 S 12 concrete
6 2
s 7 NYT0_STI7_1 120.00  NewYork  17thSteet  1.8TI7 £ 2STI7  concrete
s g NYILS
1 % open X
o g NY4B o op .
10 NY5BW & v A4 | « DEMO_USPACP > DB v @ | SearchDB p I
11 NYE_B r
Organize *  New folder = M @ 3 -
~ || DEMO_US_PACP A Name Dat: fied Type = >
Q s e @ DEMO_US_PACP.sdf 535  SDFFile
TS |:1 Misc @ DEMO_US_PACP _Meta,sdf  02/9 ¥15:34  SDFFile 7 <[> =
Observations Module 7 x
Dista v Picture ¥| CIv| Lateral ¥|Coun ¥ Scan ¥ Laser | Remarks v Ga v
1 000 2 Trash s ° s 12
2 B Video b ¥ ° °
3 2830 1 ° ¥ . .
A " e DEMO_US_PACP_3D . i . .
s 5 8546 1 DEMO_WRC5_ZA ol N o [ ° °
6 8950 1 ° K . .
7 14250 8| File name: | DEMO_US_PACP.sdf ~| | WinCan VX file based projects { ~ ° [ e e
8 1271 g | . i : :
[ arl o w2 CRPP o | | conce o ¥ . .
10 20227 2 S 4 5 :
nor @ @ e @ B B
N A 12 22336 064 LR Alignment Right, 5 % ) ° o ° ° °
" [T—Ts 13 22400 000 MSA Survey Abandoned o) ° ° @ ° ° camera cable too
MMC 11833
u = [LE—
‘% P
\ ) Metinspected|q
\__/
N s
1Check user database for update. NASSCO_PACP-6_ENG_USA_SEC/PACP-6 local\WCSYS sdf #VIEWER 0%
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Send project links to end customers

9 Send project links to end customers

In order to make uploaded projects accessible for end customers, run WinCanVX and hit the
command Tools>Manage Web Projects>Manage Web Projects:

M- WinCan VX (-PROD-) v1.2020.10.0 [Admin] - [DECMIL GROUP, PLENTY ROAD UPGRADE - STAGE 2]
Projects  Printing DataExchange | Tools | Views  WinCan Analyst Extended Modules Work Order Management Macros OEMTools  Admin
— e r—n ] "
A % 3 M ¥ B W V' LI R
AutoCreate  AutoCreate  Combine Abandoned  Insert New  Calculate Move  WinCan | ManageWeb | Pro Project Show Search and
Laterals Connections ~ Inspections Manhole Invert Levels Inspection Validator Projects - | Touch | Doc Inspected Only ¥ ARPly Filter Y Apply UserFilter  Replace
Toels Manage Web Projects Quick Filter User Filter
» DECMIL GROUP, PLENTY ROAD UPGRADE - STAGE 2 Sections | Laterals Upload Current Project p
Pipe Graph 7 X ||Sections
Joz-4 A - , = 1 Concrete reinforced
2 JO23-J022 27.82 ZONE 7,PLENTY RD, STHMG... J02-3 J02-2 Concrete reinforced 375mm
sTep 001} 3 J02-2-J0241 19.50 ZONE 7, PLENTY RD, STH MO... J02-2 J02-1 Concrete reinforced 3756mm
WLC 4 J02-1-J05-4 2035 ZONE 7, PLENTY RD, STH MO...  J02-1 J05-4 Concrete reinforced 375mm
Dec 5 HO1-2A-HOT1 1239 ZOME 6A, PLENTYRD, STHM_. HO1-2A  HO1-2 Concrete reinforced 375mm
DES 6 H6-2-HO1-2 743 ZONE 6A, PLENTY RD, STHM... HB-2 H01-2 Concrete reinforced 375mm
——DER 7 HO1-2-HO1-1 3.53 ZONE 6A PLENTY RD,STHM... H01-2 HO1-1 Concrete reinforced 750mm
g EXG2-2-EXG2-3 4895 ZONE 5, OPP LAKE BLVD, PLE... EXG2-3 EXG2-2 Concrete reinforced 375mm
g EXG2-2-RAIL.. 1712 ZONE 5, OPP LAKE BLVD, PLE... GREATE... EXG2-2 Concrete reinforced 375mm

Switch to the tab On Web and VX in the dialogue box that follows (2), select the desired project
from the list of recently uploaded projects and hit the paper clip icon (3) in order to create a
corresponding link:

| M WinCan Cloud - O x

e User ID: d.steiner@wincan.com Log out

| Local Only on'wieb On'web and VX
= Creste Date

Name Actions

DECMIL GROUP, PLEN

Upload Download | History

DEMO_CH_VSA_Murte | 20/02/2013

120082020 Upload Download | History

O
OF 0% 0%

DEMO_DE_ISYBauxXML | 110872009 | 06/0472018 722GB Upload || Download (| History

- o x

Active Till Allow Download  Customn Url Send Link Open Copy Delete

.| 310172021 ‘ | ‘ =4 | - ‘ ‘ Tuf |

? © @

Send link with email *

Please specify receiver.

| |support@wincan.com e

Send Cancel

&) )

The dialogue that follows asks you to create a link (4), set an expiration date (5) and finally send it
to the receiver (i.e. e-mail address of the end customer (6)).

Make sure the option Allow Download is checked so the end customer will be able to download the
project from WinCan-Web.
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Send project links to end customers

9.1 Direct access to projects via guest account

The end customer himself is informed immediately via e-mail that he will be able to access the
project data from now using the Web-Viewer:

Please click the link below to directly access
the WinCan WEB project

'DECMIL GROUP, PLENTY ROAD
UPGRADE - STAGE 2

If you're having trouble viewing content above, click here to access the project

When clicking on the corresponding link, he is automatically signed in on the WinCan WEB platform
with a GUEST-account, that just allows him to browse through that specific project and to download
it to his local computer (1):

O & 52 hitpsy/webwincan.com/#/app/guest-project/DECMILGROUPPLENTYROADUPGRADE-STAGE2-t2gp8l/main

B PROJECT > # DOWNLOAD PROJECT

DECMIL GROUP, PLENTY ROAD UPGRADE - STAGE
2

SECTIONS

It Nr. Asset ID

10 G15-4-G.. 37.86 ZONg] @ D

u G15-3-G.. 2151 ZONE} Project Documents m
Video not found.

Length [m] Town Suburb  Add|

ZONE

12 G15- .12

A Tools Download
1~ 13 A28-1-A. 123 ZON]
< - A,
Media bucket ¥ Download as ZIP
s 14 A15-20 - .. 3630 ZONE} = b cunlosd as
’ g
@ Drawing *  Download by Tool
11-08-20200328 (g 28 Participants ¥ Download LightViewer
_-cow ; ~
1 N me m- Code  Observation Text STRate STScore SERate SEScore Remarks
3 03 3873 GC General comment OPERATOR A..
_cow lih Scoring
=+ .
Pl 4 150 3762 SAV Some coarse aggregate is APPEARS TO..
FHSP - v

5 288 3624  CMS Multiple/complex surface cf

Some coarse aggregate is visible, at joint at 6 o'clock

7 19.80 1932 SAV Some coarse aggregate is visible, at joint at 11 o'clo. o] 00:07:50 1 200
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